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New Features for Eudora 5.1 for Mac

Welcome to Eudora 5.1! This manual describes the new features and functions in Eudora 
5.1 for the Macintosh.

■ Secure Sockets Layer (SSL). SSL, a transport security protocol, has been added to 
Eudora. SSL is used to authenticate the server and to encrypt mail transfers so no one 
can read your mail while it’s being sent to or received from your mail server. 

■ MoodWatch™. Enhancements to the MoodWatch feature for monitoring offensive 
content have been made. You can now see the offending word or phrase in the 
message. Also, you can indicate at what MoodWatch level you wish to delay sending a 
message with offending text. 

■ Enhanced Address Book in which you can display photos. You can add a person’s 
digital photo to your address book. If you correspond to a person on a regular basis, 
you can drag the person’s nickname to the toolbar where the person’s photo will 
appear. You can click on the person’s photo displayed on the toolbar, and a new 
message window appears with To field already filled in with the person’s email address.

■ New Address Book settings dialog. There is a new settings dialog where you can 
choose to turn settings on or off that pertain to your address book, including how the 
address book displays nicknames, general settings, and the new business card feature 
(vCards). 

■ Eudora now support vCards. Eudora now supports vCards, which are electronic 
business cards. You can create your very own vCard in your Eudora address book and 
attach it to an outgoing message. If someone send you a vCard, you can drag it into 
your address book and create a new nickname record automatically. 

■ Save Address Book in Comma Separated Values (CSV). You can now save address 
book entries in CSV format. This allows you to save the entire contents of your address 
book as a single CSV formatted file. With your address book open, from the File menu, 
choose Save As. The Save As dialog appears for you to save the .csv file. To save only 
selected address book entries, hold the Shift key down when selecting entries. 

■ New conduit to sync your Eudora address book with your Palm handheld 
computer. You can sync your Eudora address book and your Palm ‘s address book.

■ Signatures. You can now see your signature in the message you are composing. You 
can also edit the signature.

For details on other changes in Eudora 5.1, refer to the README and RELNOTE text files 
that reside in the folder where Eudora 5.1 is installed.
7

QUALCOMM Incorporated



 
  Secure Sockets Layer (SSL) in Eudora (Sponsored and Paid Modes only) Eudora New Features Manual 

                       
Secure Sockets Layer (SSL) in Eudora 
(Sponsored and Paid Modes only) 

Eudora now supports Secure Sockets (SSL), a security protocol for transferring informa-
tion. SSL allows you to authenticate the server that sends and receives your email 
messages. Also, SSL is used to encrypt mail transfers so no one can read your messages 
while they are being sent to or received from your mail server. 

SSL uses a security certificate system, just as most web browsers, to authenticate and 
encrypt your messages. Valid certificates should be present for SSL to work properly. 
These certificates are included in SSL and are usually updated by your ISP, email admin-
istrator, or Eudora. Valid certificates come with Eudora, and more will be provided to you 
as needed.

For both sending and receiving mail and for any personality, Eudora supports SSL through 
the new SSL settings dialog.

Important. To use SSL in Eudora, you must have Apple’s Keychain installed on your 
computer.

Using SSL 

To access SSL settings for any of your personalities, do the following:

1 From the Special menu, choose Settings. 

2 Scroll and choose SSL. The SSL settings dialog appears. 

SSL settings dialog

SSL popup menu
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3 In the Personality field, choose the desired personality from the popup menu. The SSL 
settings you will be choosing from the following fields will be for this personality. You 
can choose your dominant personality or any other personality you have previously set 
up. 

4 In the SSL for POP field, from the popup menu, choose the SSL setting for receiving 
messages from a server using the POP protocol.

In the SSL for SMTP field, from the popup menu, choose the SSL setting for sending 
messages to a server using the SMTP protocol.

In the SSL for IMAP field, from the popup menu, choose the SSL setting for receiving 
messages from a server using the IMAP protocol.

5 After you select the desired protocol, choose one of the following from the popup 
menu:

■  Never—Do not use SSL for server authentication and mail transfer security, even if 
SSL is available on the server. 

■  Required (TLS) (default)—Use SSL for server authentication and mail transfer 
security by having Eudora automatically invoke the STARTTLS command method 
to start SSL. If your server does not support STARTTLS, mail transfers will fail.

■  Optional (TLS)—Use SSL for server authentication and mail transfer security by 
having Eudora automatically invoke the TLS command method to start SSL, that is, 
if the server supports TLS. If your server doesn’t support TLS, mail transfers will 
occur successfully, but they will not be secured with SSL. 

■  Required (Alternate Port)—Use SSL for server authentication and mail transfer 
security by having Eudora automatically use the older style alternate port method 
for starting SSL. If your server does not support SSL on the appropriate ports, mail 
transfers will fail. 

Important. If you use SSL and cannot make a connection when receiving or sending mail, 
you may need to check with your ISP to update any invalid SSL certificates. However, to 
override any issues with SSL when retrieving or sending mail, choose Never from the 
drop-down menu to make a successful connection.
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Using MoodWatch
(Sponsored and Paid Modes only)

MoodWatch, introduced in Eudora 5.0, monitors incoming and outgoing messages for 
offensive text. 

In Eudora 5.1. MoodWatch works similar to Eudora’s spell checker by indicating which 
words or phrases trigger the chili peppers to appear. The words or phrases now appear 
bold in a different color. 

Also, new settings have been added to the MoodWatch options window where you can tell 
Eudora to hold offending messages for ten minutes before sending them. See “Mood-
Watch Settings” below for more information.

MoodWatch Settings

You can change MoodWatch settings in the MoodWatch options window. In this window, 
you can determine at what level you wish your messages to be monitored before a 
warning appears telling you that, perhaps, your message content may be offensive to your 
recipient. You can also set Eudora to hold messages that contain offensive text for ten 
minutes before you send them. 

You can set MoodWatch to monitor incoming and stored messages for offensive content 
as well.

If you don't want to use MoodWatch at all, you can turn it off in this window. Also, you can 
choose if you want to use MoodWatch for incoming messages only, outgoing messages 
only, or both.

To display the MoodWatch settings window, do the following:

1 From the Special menu, choose Settings.

2 Scroll and click the MoodWatch icon. The MoodWatch settings window appears.
10
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MoodWatch settings dialog

3 Choose the settings you want to change. Settings are described below:

Enable MoodWatch—If checked, MoodWatch is on. To turn MoodWatch off, just uncheck 
the box.

Warn when queueing/sending—The following options warn you when MoodWatch 
detects anything that may be offensive in your message when queueing or sending. 

If the message seems like it might be offensive—Turn this setting on to set Mood-
Watch to its most sensitive level. If your message has some content that looks like it 
might be offensive (one chili pepper appearing), you will be warned when you queue it.

If the message is probably offensive—Turn this setting on to set MoodWatch to a 
medium sensitivity level. If your message has some content that looks like it is offen-
sive (two chili peppers appearing), you will be warned when you queue it.

If the message is on fire—Turn this setting on to set MoodWatch to a low sensitivity 
level. If your message has some content that is offensive (three chili peppers 
appearing), you will be warned when you queue it.

Never—Turn this setting on to never display a warning in your outgoing messages, 
despite offensive text in its content.

Delay when queuing/sending—The following options allow you to delay sending an 
offending message giving you time to “cool off.” During the delay period, you can either 
delete the message or send it. After the delay period is over, your message will be sent.

If the message seems like it might be offensive—Turn this setting on to delay a 
message to be sent when MoodWatch is at its most sensitive level. If your message 
has some content that looks like it might be offensive (one chili pepper or more 
appearing), your message will sit in your Out box for ten minutes before Eudora sends 
it.

If the message is probably offensive—Turn this setting on to set MoodWatch to a 
medium sensitivity level. If your message has some content that looks like it is offen-
sive (two chili peppers or more appearing), your message will sit in your Out box for ten 
minutes before Eudora sends it.
11
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If the message is on fire—Turn this setting on to set MoodWatch to a low sensitivity 
level. If your message has some content that is offensive (three chili peppers 
appearing), your message will sit in your Out box for ten minutes before Eudora sends 
it.

Never—Turn this setting on to never delay your outgoing messages being sent, despite 
offensive text in its content.

Scanning incoming mail

Scan new mail as it arrives—Turn this setting on to allow MoodWatch to scan all of 
your incoming mail. MoodWatch determines the level of offensive text contained in the 
message. MoodWatch then displays one, two, or three chili peppers in the MoodWatch 
column of the mailbox where the message resides.

Scan stored mail in the background—Turn this setting on to allow MoodWatch to 
scan all of your stored messages. MoodWatch determines the level of offensive text 
contained in each message. MoodWatch then displays one, two, or three chili peppers 
in the MoodWatch column of the mailbox where the message resides.
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Photos in Eudora’s Address Book 
(Sponsored and Paid Modes only)

In the Eudora Address Book, a new panel has been added to a person’s nickname record. 
You can add a person’s digital photo to your address book. If you correspond with a 
person on a regular basis, you can drag the person’s nickname to the toolbar where that 
photo will appear. You can click on the person’s photo displayed on the toolbar, and a new 
message window appears with its To field already filled in with the person’s email address.

To add a photo to the address book, do the following:

1 From the Window menu, choose Address Book or click the Address Book tab.

2 Choose the nickname for the person whose photo you want to add.

3 Click the Photo tab. The Photo panel appears.

Address Book photo panel

4 At the bottom of the Photo panel, click Select Photo... The Choose a Photo dialog 
appears.
13
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Choose a Photo dialog

5 From the Choose a Photo dialog, search and choose the photo. Click Select. The 
photo appears in the Photo panel in your Address Book.

Photo panel showing photo

6 To move the photo to the toolbar, choose the nickname and drag it to the place on the 
toolbar you want the picture to appear.

nickname photo on the toolbar

7 To send a message to the person whose photo is on the toolbar, click the photo. A new 
message window appears with the person’s email address automatically entered in the 
To field.

To forward a message, from an open mailbox, choose and drag the message and hold 
it over the person’s photo. The forward and redirect icon buttons appear. Choose the 

Forward icon button  in the popup menu.
14
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To redirect a message, from an open mailbox, choose and drag the message and hold 
it over the person’s photo. The forward and redirect icon buttons appear. Choose the 

Redirect icon button  in the popup menu. 
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Address Book Settings 

Here, you can choose to turn settings on or off that pertain to your address book, including 
how the address book displays nicknames, general settings, and settings for the business 
card feature (vCards). 

To display the Address Book settings dialog, do the following:

1 From the Special menu, choose Settings.

2 Scroll and click the Address Book icon. The Address Book settings dialog appears.

Address Book settings 

Select the settings you want to change. Settings are described below.

Display

Show History List in Address Book—When this setting is on, the History List, the email 
addresses of the most recent people you have sent messages to, appear in your nickname 
list as an address book called History List. 

Append nickname text when sorting by value fields—When this setting is on, the nick-
name you assigned to the person will be added to the name, address, city, and so forth 
when you perform a sort. 

Allow nicknames to be renamed in the list—When this setting is on, you are allowed to 
rename a nickname directly on the Nickname list. If this setting is off, you can still rename 
the nickname, but you must change it in the Nickname field only after you select the nick-
name from the Nickname list.
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General

Backup address books (and use LOTS of disk space)—When this setting is on, your 
address book is automatically backed up when you exit Eudora. It is recommended to turn 
this function on occasionally because of disk space considerations.

Save address books using “Fast Save”— When this setting is on, Eudora saves your 
address books using speedy updates instead of traditional saving methods.

Auto-expand address books during nickname drags—When this setting is on, the 
address book expands to display all of its nicknames when you drag a nickname to this 
address book.

Maintain PDA syncing information—When this setting is on, information in your address 
book is formatted to automatically sync with your Palm handheld computer.

Business Cards

Support vCard features in Eudora—When this setting is on, you can create and use 
vCards, which is an electronic business card, in your address book.

Hide personal vCards in Address Book—When this setting is on, the personal vCards 
you receive and drag into the address book are hidden.

Hide vCard button in message windows—When this setting is on, the single name 
(yours) that appears at the root level of the Nickname list is hidden. The name is your 
Personal vCard.

Don’t allow suspiciously formatted vCards—When this setting is on, any vCard you 
receive that Eudora detects as not formatted properly will be rejected.

Use “home” tab as default location—When this setting is on, information such as 
phone, city, state, and so forth, will populate the Home panel fields in your address book. If 
this setting is off, the information will populate the Work panel fields.
17
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Using vCards in Eudora 

Eudora now supports vCards, which are electronic business cards. You can create your 
very own vCard in your Eudora address book and attach it to an outgoing message. If 
someone sends you a vCard, you can drag it into your address book and create a new 
nickname record automatically. 

Creating Your vCard

To create vCard in your address book, you must perform two steps: turn on the vCard 
feature in the Settings dialog and set up a vCard record for yourself in you address book.

To create a vCard in your address book, do the following:

1 From the Special menu, choose Settings.

2 Scroll and choose Address Book. The Address Book settings dialog appears.

3 In the Address Book Settings dialog, check the Support vCard features in Eudora 
box.

4 Click OK.

5 From the Window menu, choose Address Book. The Address Book opens. Notice 
that on the top of the nickname list is your name.

6 Highlight your name located on the top of the nickname list.

7 Enter the information that you want to appear on your vCard.

8 To save your vCard, from the File menu, choose Save. The vCard icon  appears to 
the left of your name.

Attaching Your vCard to a Message

You can attach your vCard to any message you send. It will contain the information you 
entered on the Home panel in your address book.

To attach a vCard to a message, do the following:

■ In an open message, click the vCard button . The vCard appears in the Attach-
ments field in the header with a .vcf extension.

Using a vCard to Create an Address Book Entry

If someone sends you a message with a vCard attached (usually with a .vcf extension), 
you can drag the attachment and create a new address book entry.
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To create an address book entry from a vCard, do the following:

■ From an open message, drag the vCard into the selected address book within your 
opened Eudora address book. The person’s name appears in the nickname list of that 
address book, and the vCard information appears.
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Syncing Address Books with Palmtm OS 
Devices

Eudora now includes a conduit to synchronize your Eudora address book on your desktop 
computer with the address book database in your Palm OS  handheld computer. This 
process synchronizes your Eudora Nicknames file with your Palm address book entries. 

Note. If you have multiple copies of Eudora installed and running on your computer, you 
can synchronize the Palm handheld with only one of them.

Important. You must have version 2.6 of the Palm HotSync software installed on your 
computer. If you have an older version, you can download the latest version from the Palm 
Computing web site at < http://www.palm.com/support/macintosh/>. Also, the Address 
Book Conduit will work only with Eudora 5.1 or newer.

There are three tasks you need to perform before you can synchronize Eudora's address 
book with your Palm address book entries:

1 Make a back up of your Eudora Nickname file and folder.

2 Install the conduit.

3 Configure the conduit.

Consider the following issues when synchronizing:

■ Eudora must be running. If Eudora is not running, the conduit will launch Eudora. You 
can adjust this behavior in the Conduit Settings window in your Palm Desktop software.

■ Make sure the Address Book window is closed and saved before doing a HotSync 
operation.

■ Modifying the Eudora Address Book during a HotSync will cause the HotSync opera-
tion to fail.

■ New Palm address book entries are copied into your Eudora Nicknames file.

Making a Backup of Your Eudora Nickname File and Folder

It is recommended that you make a backup of your Eudora Nickname file and folder on 
your desktop computer just in case the results of the sync are not what you expect.

To make a backup of your Eudora Nickname file and folder, do the following:

1 Find the Eudora Folder on your Macintosh.

2 Make a copy of the Eudora Nicknames file and the Nicknames Folder and move it to 
another location. This is your backup copy. You can use this copy of the HotSync oper-
ation if it does not produce the results you want.
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Installing the Eudora Address Book Conduit

Before you can sync with Eudora, you need to install the Eudora Address book conduit in 
the Palm ‘s desktop Conduits folder.

To install the conduit, do the following:

1 On your Macintosh, locate the Palm Desktop Software folder. This is the folder that 
contains the active copy of the Serial Port Monitor. It will be inside of the folder installed 
by the Palm desktop software.

2 Place the Eudora Address Book conduit into the conduits folder. The conduit is 
included as a separate entity when you download Eudora 5.1.

3 From Palm’s Conduit folder, remove Palm’s Address Book conduit or any other 
conduit that syncs address books.

OR

From the HotSync menu, choose Conduit Settings. Palm’s HotSync software allows 
you to disable duplicate conduits.

The Eudora Address Book conduit is installed.

Configuring the Eudora Address Book Conduit

After you install the Eudora Address Book conduit, you should configure how you want to 
use the Eudora Address Book conduit.

To configure the conduit, do the following:

1 Launch your Palm Desktop software.

2 From the Palm Desktop software menu, choose Conduit Settings. The Palm’s 
Conduit Settings dialog appears.

Conduit Settings dialog

3 Click the button you wish to determine what kind of synchronization will be done the 
next time you perform a HotSync. Following is a description of the options:
21
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■  Synchronize the files will synchronize all address book entries on both your Palm 
device and desktop computer. 

■  Macintosh overwrites handheld will replace all of your Palm’s address book 
entries with your Eudora address book entries. 

■  Handheld overwrites Macintosh will replace all of your address book entries in 
Eudora with your Palm’s address book entries. 

■  Do Nothing disables the Eudora Address Book conduit.

4 To choose the currently selected HotSync action as the default, click Make Default.

5 To locate a certain Eudora settings file you would like the conduit to synchronize with, 
click the long button under Synchronize with this Eudora Settings File. If you fail to 
do this step, the conduit will use whatever copy of Eudora is running the first time you 
perform a HotSync operation. This option is useful if you need to change which 
instance of Eudora the conduit syncs with.

6 To tell the conduit to synchronize all of your address books files in Eudora, and not just 
the Eudora Nickname files, check the Synchronize all address book files box. By 
default, only your Eudora Nicknames file is synchronized.

7 If you're using one or more of the Custom fields available in the Palm Address Book or 
want finer control over the synchronization process, you may want to see some addi-
tional settings. The More Settings button will give you access to a few other esoteric 
conduit settings:

Additional Address Book Conduit Settings dialog

Check the Do Nothing if Eudora isn't already running box if you'd like the conduit to 
not launch Eudora each time a HotSync is performed, and synchronize only when 
Eudora is already open and running.

Choose the other buttons to tell the conduit where to store the Eudora nickname when 
saving Eudora contacts to the palm. Since the Palm Address Book doesn't have a field 
to store a nickname in a contact, the conduit will attempt to use the first available 
Custom field. The radio buttons will allow you to configure to conduit to save the 
Eudora nickname in a specific location.

8 Click OK.

The Eudora Address Book conduit is now configured.
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Syncing with Eudora and Palm

To sync with Eudora and Palm, do the following:

1 Launch Eudora. 

2 On your Palm cradle, press the HotSync button. The conduit will automatically 
configure itself to sync with the running copy of Eudora if it needs to. Otherwise, the 
selected HotSync operation will be performed.

The entries in your Eudora Address Books are added to the address database on your 
Palm device, and the address book entries on your Palm will be added to your Eudora 
Nickname file.

Note. You can sync all address book entries, not just ones you have changed by doing a 
“slow sync.” Do a slow sync by holding down the shift key before the conduit starts up. Do 
a slow sync if there are contacts on either the Palm device or in Eudora that aren’t being 
synced. This will result in duplicates, but it will insure that every contact is copied to both 
your computer and your Palm device.
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